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[bookmark: _GoBack]Abstract:

In this laboratory exercise students use digital cameras to measure surface fluorescence of transgenic plants expressing green fluorescence protein (GFP).  Inquiry pedagogy is used to teach processes used in scientific investigations and how GFP is used in reporter gene systems.  Students start by making observations involving induction of expression of a GFP expressing reporter gene and then use their observations to develop a testable hypothesis regarding possible environmental or developmental signals responsible for inducing gene expression. The students design and conduct an experiment to evaluate their hypothesis.  In their experiments, the students assess GFP expression by taking photographs with a digital camera attached to an epifluorescence filter cube.  Open source software is used to quantify the amount of green surface fluorescence observed in the students’ photographs.  After performing basic statistical analysis, the students report on their findings by writing a scientific poster.

The epifluorescence filter cube that enables the camera to detect GFP fluorescence is relatively inexpensive because it is constructed largely from consumer goods.  The filter holder is made from hardboard.  The illumination source is a 5 watt light emitting diode (LED), and the lens tube is made from plastic plumbing pipe.  The specialty materials are a set of dichroic filters.  To reduce costs, mass production machine vision filters are used as excitation and barrier filters.  The most expensive component is the beam splitting filter.

Materials included with the manuscript are instructor’s notes, instructions on how to construct the camera attachment, a student handout explaining how to use ImageJ to quantify surface fluorescence, an example assignment where students investigate the specificity of the Arabidopsis thaliana alcohol dehydrogenase (ADH) gene promoter, Power Point slides with a lecture outline, a grading rubric, and an example of a good scientific poster.


Learning objectives:

The described laboratory activities are designed to advance key goals identified in the National Research Council Bio2010 report (National Research Council, 2003) and the American Association for the Advancement of Science (2009) Vision and Change report.  The following learning objectives are addressed in this assignment.  Students will:
· develop an understanding of the scientific method.
· design an experiment with appropriate controls.
· use quantitative reasoning skills to develop conclusions from experimental data.
· develop skills in the use of computers to acquire and analyze data.
· obtain a basic understanding of the nature of digital images.
· gain an understanding that plants respond to environmental changes or to developmental cues by changing their gene expression. 
The learning objectives are addressed by having students conduct quantitative investigations with transgenic plants expressing a differentially regulated promoter.  The gene encoding green fluorescent protein (designated as gfp in this manuscript) has become a widely used reporter gene because it can be detected in vivo by illuminating the organism with excitation light (Hraška, Rakouský, and Čurn, 2006).  In this exercise, plants expressing enhanced GFP (EGFP) (Zhang, Gurtu, and Kain, 1996) are used because EGFP fluorescence can be detected by exposing plants to visible blue light (Patterson, Day, and Piston, 2001), a safe and non-destructive assay (Hraška, Rakouský, and Čurn, 2006).

In the investigation presented here, students are asked to determine the specificity of an environmentally regulated promoter.   To place the investigation in context, the students are introduced to the concept of acclimation, the process of changing physiology in response to stress.  Gene expression changes are often associated with acclimation.  The promoter that is used for this investigation is from the Arabidopsis thaliana (L.) Heynh. (arabidopsis or mouse ear cress) alcohol dehydrogenase gene (Manak et al., 2002).  Along with being induced by ethanol, the gene can be induced by other abiotic stress such as hypoxia, and dehydration.  However, other abiotic stresses like low temperature does not induce gene expression (Dolferus et al., 1994).  The students first conduct an exercise where they learn how to detect and measure GFP expression with a digital camera containing an epifluorescence filter cube attachment (Baker et al., 2012).  They observe that GFP expression is induced when leaves become dehydrated.  They learn how to use ImageJ software (Rasband, 2013) to quantify fluorescence and how to do basic statistical analysis of their data (i.e., calculate 95% confidence intervals).  The students are then asked to propose an experiment to determine the specificity of the environmental cues that cause induction of gene expression.  To ensure that the students are conducting an inquiry investigation, the students are not told the identity of the promoter.  After having their research plan critiqued by the instructor to ensure a proper experimental design is used, the students working in small groups conduct their experiment.  The students report their findings in the format of a scientific poster.

[bookmark: h.gjdgxs]The exercise can be altered to teach key aspects of plant development or physiology because over a thousand GFP expressing lines are available at the Arabidopsis Biological Resource Center (ABRC, http://abrc.osu.edu/).  Many lines produce expression patterns that can be observed at the macroscopic level.  For example, students can learn about plant development by using a kit created by Sarah Wyatt and provided by ABRC that contains eight transgenic lines that show different patterns of expression in roots, stems, leaves and flowers (stock number CS20000).  Additionally, 33 transgenic lines that express GFP in a variety of different developmental patterns have been donated by Scott Poethig (stock numbers CS24240 through CS24272).  


Timeframe:

To conduct the laboratory investigation, A. thaliana seed stocks that are homozygous for green fluorescent protein reporter genes (gfp) are needed.  If the instructor has a small seed supply, eight weeks or more will be needed to amplify the stocks.  Once the seed stocks are produced, they will remain viable for years when stored at 4 °C.  Seeds should be sown a week before the planned laboratory experiments.  Software installation and camera set up can be completed in a few hours.  

As written, the students’ laboratory investigation is designed to be taught during one three-hour laboratory period.  During the laboratory session students do activities that teach them how to manipulate the plants, take fluorescent photographs, and manipulate the digital images.  At the next laboratory session, the students submit a short research proposal which is then critiqued by the instructor.  I have found the easiest way to critique the student proposals is to hold small-group discussions during the laboratory session.  In the discussion the students should explicitly state what they plan to use as a positive control, a negative control, and define their treatments.  Additionally, the students should state what data they plan to collect, and what type of data analysis they plan to use.  I have found the critique process takes about 15 minutes per group of four students.  I do these discussions during a laboratory class period while the students are conducting experiments not related to this assignment.  The students are expected to conduct their inquiry investigation outside of class hours.  They can conduct their experiments in two to three weeks, and need another week to write up laboratory reports.  As described, only one three hour laboratory period is required for this assignment.  The instructor will likely need to spend significant time outside of class helping the students with setting up their experiments.


List of materials:
[bookmark: h.30j0zll]
This laboratory exercise uses homozygous plants containing environmentally regulated gfp reporter genes.  The transgenic line used was provided by Robert Ferl (Horticultural Sciences Department, University of Florida, Gainesville, Florida, USA) and is described in Manak et al. (2002).  Positive and negative controls are used in the investigation.  An example of an appropriate positive control is ABRC stock CS84732  which contains a 35S/gfp chimeric gene that constitutively expresses GFP (Cutler et al., 2000).  The appropriate negative control would be the wild type line (a.k.a., ecotype) which is the same genetic background used to create the transgenic line under investigation.  The ARBC provides the genetic background information of their holdings.

To conduct the instructional activities, the following materials will be needed:
· Digital single-lens reflex (SLR) camera with a universal serial bus (USB) connection to a desktop computer or an external shutter cable.
· Fixed-focal length macro lens.  The ideal focal length is 100 mm, though a 50 mm lens is sufficient.
· An opaque box to cover the camera when taking fluorescent photographs.  A large cardboard box is sufficient.
· Camera stand or stout ring stand with ring support to hold the camera during photography.
· Personal computer.
· Camera manufacturer’s software for image processing.  Cannon’s (Canon USA, Lake Success, NY, USA) standard software package allows for computer control of the camera and automatic image download.  Other manufacturers produce remote control software as separate packages.  Computer control of the camera does speed the process but is not essential to complete the activities.
· Optional: A memory card reader will be needed if there is no direct connection between the camera and a computer.  Many laptop computers have secure digital card (SD card) readers built into their standard configuration.
· The software package ImageJ (Rasband, 2013). 
· The ImageJ plug-in DCRaw (Coffin, 2014).  Windows and Linux executable versions of the plug-in are provided by (Sacha, 2014).  An Apple OS executable version can be downloaded from (Montilla, 2013).
· Small pots.  Plastic cups can be used if drainage holes are placed in the bottom.
· Plants are grown in peat-based potting soil.  Pre-fertilized potting soil mixes work well.  If standard potting soil is used, then the soil needs to be fertilized with a commercial fertilizer that contains micronutrients.  Follow the manufactory’s recommendations when applying the fertilizer.  Alternately, a 1:1:1 mixture of peat, perlite, and vermiculite can be used.
· Autoclave or microwave oven.
· To plant individual seeds, they should be suspended in a viscous solution.   An ideal solution is 0.1% agar that has been autoclaved or microwaved.
· Test tubes.
· Pasteur pipettes with bulb or transfer pipettes.
· Plastic wrap to cover pots during germination.
· Refrigerator or cold room to cold treat sown seeds.
· An illuminated space to grow plants.  The plants grow well under cool-white fluorescent bulbs. 
· Optional: 2.5 cm X 3.0 cm black foam board section to support individual leaves during photography.
· Camera filter cube attachment (Baker et al., 2012).  Details on how to build one will be provided below.



Procedure and general instructions (for instructor). 

Growing arabidopsis

A. thaliana has become the “fruit fly of the plant world” because it has many of the advantages of drosophila. This includes small size, rapid development, and ease of growth.  Like drosophila, some simple but specialized techniques are used in the laboratory.  Detailed descriptions of how to grow plants, collect seeds, and store stocks are readily available (Rivero-Lepinckas, Crist, and Scholl, 1998; Arabidopsis Biological Resource Center, 2014).  Resources have been created to teach students how to grow and analyze arabidopsis.  The Partnership for Research and Education in Plants at Virginia Polytechnic Institute has developed a series of online videos (Dolan et al., 2014).   Though designed for high school students, the sections on time lines, growth and development, anatomy, and the video sections on growing techniques are appropriate resources for this assignment.  The next few sections are summaries of the techniques needed to conduct the exercise.  If more information is needed, refer to the Arabidopsis Biological Resource Center (2014), Dolan et al. (2014), or Rivero-Lepinckas, Crist, and Scholl, (1998).


Sowing seeds

Because of the small size of arabidopsis seeds, sowing well-spaced seeds can be difficult.  Spacing the seeds is important because seed yields go down if the plant density is too high.  Depending on the ecotype used, maximum seed yield occurs at a planting density of 0.1 to 0.2 seeds per cm2 (Arabidopsis Biological Resource Center, 2014).  Additionally, high plant density interferes with the photography of the plants.  One good handling method is to place a small aliquot of seeds in a test tube and suspend the seeds in a viscous solution of room temperature 0.1% agar.   The seeds are suspended by sucking the seeds up and down using a glass Pasteur pipette or a plastic transfer pipette.  After the seeds are in suspension, remove an aliquot with the pipette and place well-spaced drops onto the potting medium.  Look through the tip of the pipette while planting.  If drops have more than one seed, add more 0.1% agar to the test tube and suspend the seeds.  If there are drops with no seeds, place additional drops on the potting medium until the desired number of seeds are sown.

To prepare 0.1% agar, place 0.1 g of agar and 100 ml of distilled or deionized H2O (dH2O) into a > 200 ml screw-cap bottle.  The agar will not dissolve in room temperature water.  Sterilize the mixture by placing the cap loosely on the bottle and autoclaving at the liquids setting for 15 minutes at standard temperature and pressure (STP).  The agar will dissolve during autoclaving.  Alternatively, the agar can be dissolved by bringing the mixture to a boil in a microwave oven with occasional mixing.  Let the resulting solution cool to room temperature before using.  The agar solution will store several months at room temperature if kept sterile.  If fungal mycelia or other growths are seen in the agar, discard the solution.


Plant growth and seed harvesting

Germinating arabidopsis seeds are sensitive to dehydration.  To ensure successful germination, place clear plastic wrap over the pots.  Cold treatments help to produce uniform germination.  Place the sown pots in a cold room or refrigerator and incubate at 4 °C for three or more days.  Place the pots under cool white fluorescent lights at a fluence rate of 100 to 150 μE/m2/s (~7,400 to 11,000  lux) and incubate at 23 + 2 °C  (Rivero-Lepinckas, Crist, and Scholl, 1998; Arabidopsis Biological Resource Center, 2014).  A 24 hour photoperiod produces the fastest plant growth.  Seeds usually germinate in three days.  Once germination has started, cut slits into the plastic wrap to allow the slow reduction of humidity.  Remove the plastic wrap after the plants have acclimated for one to three days.  The developing seedlings will start producing true leaves in about a week. 

Plant development can be manipulated by altering the growing conditions.  To induce rapid flowering, grow the plants under a mixture of cool white fluorescent and incandescent lights with a 24 hour photoperiod.  Flowering is delayed by growing the plants without incandescent lights with a 12 hour photoperiod.

The seed stocks should be evaluated to ensure they are homozygous by sowing a few dozen seeds and evaluating the appropriate phenotype.  The phenotype evaluated can be GFP fluorescence or the link selectable marker used to create the transgenic plant lines.  If you use the selectable marker, refer to the original paper that described the creation of the transgenic line to determine the selection conditions.

If the seed stocks appear to be segregating, homozygous lines need to be generated.  To do this, collect seeds from individual F1 plants as described in Section 4.1 of Arabidopsis Biological Resource Center (2014).  Seed ripening can be accelerated by withholding water from the plants once some of the siliques (i.e., seed pods) start to yellow.  Some reduction in seed yield will occur.  Do not mix the seed lines together.  Evaluate phenotype segregation again to identify which lines are homozygous.  Homozygous lines can be bulked together.

Because of the small size of arabidopsis seeds, some special techniques will be needed to harvest seeds.  To isolate seeds from individual plants, bags should be placed around plants before siliques started releasing seeds.  If seed release has started, let the plants grow separated from each other.  Once several siliques start to turn yellow or brown, the entire aerial portion of the plants can be gingerly cut from the root crown and gently placed in paper envelopes.  Leave the envelopes at room temperature for several days for the plant material to dehydrate.  Once the seeds have dried, they can be removed from the siliques by vigorously shaking or patting the paper envelopes.  To remove the seeds from the chaff, pour the plant material through a fine mesh (~0.425 mm opening) sieve such as a No. 40 U.S. standard screen.  Many household stainless steel tea strainers have small enough mesh to be used in threshing.  If there are small particles in the chaff, the seeds may need to pass through the mesh several times.  After threshing, place the seeds in small (e.g., 2 dram) glass vials and store at 4 OC or -20 OC.  

Because GFP expressing plants are transgenic, care should be taken to ensure environmental containment.  Procedures need to be established so seeds are not released outdoors or grown outside intended areas (i.e., do not allow students to remove their plants from the laboratory). Pest control should be undertaken to prevent the spread of transgenic pollen.  All material, such as used potting media and plant debris, should be autoclaved or incinerated before they are placed into municipal trash streams.  For details see the National Institutes of Health (NIH) Guidelines (2014) recombinant DNA guidelines.  You should check with your Institutional Biosafety Committee regarding institution specific policies and procedures.  In most cases, the use of transgenic plants will be found “exempt” from NIH guidelines.  


Building the epifluorescence attachment

GFP fluorescence can be photographed by using a filter cube assembly (Baker et al., 2012).  The device is relatively inexpensive because it largely relies on mass production consumer materials.  The items needed to construct the apparatus are listed in Table I.  The tools needed are listed in Table II.  These lists are meant to help identify materials.  Vendors and items can be substituted.

The illumination system consists of a royal blue light emitting diode (LED) with a heat management system and a plastic tube containing optical components (Figure 1).  To start assembling the illumination system, attach 20 or 24 gauge insulated wires (Table 1 - Item 1) to a 5 watt royal blue LED mounted on a metal core printed circuit board (MCPCB) (Item 2) (Figure 2).  To do this, solder (Table II - Tool 1 and Item 3) a red wire to the positive terminal and a black wire to the negative terminal of the LED-MCPCB.  A tutorial illustrating the process can be viewed through YouTube (http://youtu.be/hZolSXk0qR8).  To remove heat from the LED, a heat sink (Item 4) needs to be attached to the LED-MCPCB.  Clean the flat surface of the LED-MCPCB with an isopropanol or ethanol soaked pad.  Do the same to the heat sink if it is not pre-mounted with thermally conducting tape.  Once the isopropanol is dry, remove the backing on the thermally conductive tape and affix the LED-MCPCB to the center of the heat sink.  A tutorial illustrating the process can be viewed through YouTube (http://youtu.be/ZD3UFZiaZ74).  A small hole should be drilled (Tools 2 and 3) next to the LED-MCPCB so the wires can be threaded through it (Figure 2).  To supply power to the LED, attach the other end of the wires to an alternating current input (AC) LED driver (Item 5).  Follow the directions provided by the LED driver manufacturer.   Make sure the LED driver used does not produce more current than the LED’s rating.  If not included, attach a power cord (Item 6) to the AC LED driver in accordance with the manufacturer’s instructions.  When testing the LED, do not look directly into the light as the bright light can damage the eyes.  Test the LED assembly by plugging the cord into an electric outlet.



Table I: Filter Cube Attachment Material List
	Item
	Description
	Vendor
	Catalog number
& Price (2015)

	1
	20 to 24 gauge insulated electrical wire (91 cm)
	LED Supply
http://www.ledsupply.com
	WIRE-20-2COND $7.47

	2
	Luxeon Rebel - Endor Star 1-Up Royal-Blue High Power LED, 700 mA
	LED Supply
	07040-PR000-B $4.83

	3
	Electrical solder
	Home Depot
http://www.homedepot.com
	SKU # 296497 $3.47

	4
	Heat sink with thermal tape, 35mm X 35mm X 18mm or 35 mm diameter X 20 mm
	LED Supply
	HS13137 
$4.99

	5
	700 mA constant current output alternating current input LED driver
	LED Supply
	LD-CU7021AF $16.99

	6
	Power cord with plug
	LED Supply
	Q114
$2.49

	7
	Polyethylene pipe, black, 25.4 mm (1 inch) diameter, 61 cm (2 ft.)
	Home Depot
	SKU # 294122 $1.20

	8
	Interior split retaining ring, 25.4 mm (1 inch) diameter, 4 needed
	Home Depot
	SKU # 605121 $3.80

	9
	SM1 Retaining Ring, 4 needed
	Thorlabs Inc.
http://www.thorlabs.com
	SM1RR 
$18.00

	10
	Aspheric condenser lens with 600 grit diffuser, diameter = 25 mm, focal length = 20 mm, 350 nm - 700 nm anti-reflective coating
	Thorlabs Inc.
	ACL2520U-DG6-A
$27.70

	11
	O-rings, 25.4 mm (1") outer diameter X 19.05 mm (3/4") inner diameter x 3.175 mm (1/8")
	Home Depot
	SKU # 584045 $2.27

	12
	Magenta dichroic filter, 25 mm diameter 
	Edmund Optics
http://www.edmundoptics.com
	#52-540 
$27.50

	13
	Plano-convex lens, diameter 25 mm, focal length = 40 mm, 350-700 nm anti-reflective coating
	Thorlabs Inc.
	LA1422-A 
$31.90

	14
	Synthetic adhesive such as Amazing Goop
	Home Depot
	SKU # 719315
$4.57

	15
	Hardboard (a.k.a., Masonite), 3.175 mm (1/8 inch) thick
	Home Depot
	SKU # 619375 $5.97

	16
	Flat black spray paint
	Home Depot
	SKU # 621138 $3.87

	17
	Cokin A-Series filter holder
	Adorama
http://www.adorama.com
	CKBPA 
$12.00


Table I continued: Filter Cube Attachment Material List
	Item
	Description
	Vendor
	Catalog number

	18
	Cokin adapter ring for camera lens, 32 mm to 62 mm
	Adorama
	Varies by adapter 
~$16.00

	19
	Mending plates, 51 mm (2 inches) x 15 mm (5/8 inch) x 2 mm (1/16 inch)
	Home Depot
	SKU # 339482 $2.48

	20
	45O Beam splitting blue-reflecting dichroic filter, 50mm square 
	Edmund Optics
	#47-949 
$120.00

	21
	Optional: Elmer's Rubber Cement
	Office Depot
http://www.officedepot.com
	443650
$2.88

	22
	Yellow dichroic filter 50 mm diameter
	Edmund Optics
	#52-544
$45.00

	23
	Cyan dichroic filter 50 mm diameter

	Edmund Optics
	#52-538
$40.00




Table II:  Tools to construct filter cube
	Item
	Description
	Vendor
	Catalog number
& Price (2015)

	1
	Soldering iron
	Home Depot
http://www.homedepot.com
	SKU # 1000011092
$19.95

	2
	Electric drill
	Home Depot
	SKU # 1000052302 $29.97

	3
	Drill bits
	Home Depot
	SKU # 778321 $12.97

	4
	Pipe cutter
	Home Depot
	SKU # 100021967 $14.98

	5
	Retaining ring pliers, extra long
	Home Depot
	Internet # 205944344 
$26.44

	6
	Wood dowel, 25 mm (1 inch) diameter
	Home Depot
	SKU # 148318
$3.98

	7
	Miter box and saw set
	Home Depot
	SKU # 1000032912 $7.98

	8
	Hole saw set: Diameter needed are 
51 mm (2 inches), 39 mm (1 1/2 inches), and 32 mm (1 1/4th inches)
	Home Depot
	Internet # 203163436 
$16.97

	9
	Combination square ruler
	Home Depot
	SKU # 677051 
$9.96


[image: ]Figure 1: Schematic of epifluorescence attachment.  (Left) Digital SLR camera with attached filter cube assembly.  (Right) Assembly schematic.  A, Heat sink.  B, Royal blue LED.  C, Frosted aspheric condenser lens.  D, Magenta excitation filter.  E, Plano-convex lens.  F, Filter cube holding beam-splitting dichroic filter at 45o angle to the LED light beam axis.  G, Optional cyan barrier filter held in the filter holder.  The cyan filter blocks red light.  H, Yellow barrier filter held in the filter holder.  This filter blocks blue light.  I, Cokin A-series filter holder attached to the filter cube assembly and barrier filters.  The black bar is a 1 cm size standard.
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Figure 2: Light emitting diode (LED) with heat management system.   Wires were soldered onto the positive (red wire) and negative (black wire) terminals of this hexangular metal core printed circuit board (MCPCB) terminals before the MCPCB was mounded onto a heat sink with double sided thermally conducting tape.  Some of the thermally conducting tape can be seen around the edge of the MCPCB.  A small hole was drilled into the heat sink so the wires could be threaded through it.
















The collimating optics and an excitation filter are housed inside a 25.4 mm (1 inch) inner diameter (I.D.) black polyethylene pipe (Item 7) which is commonly used in lawn sprinkler systems (Figure 3).  Use a pipe cutting (Tool 4) to cut the tube to a length of 45 mm.  Make sure both sides of the tube are cut at right angles to the tube’s axis.   
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Figure 3: Components of the collimating optics.  Panel I: Cut-away view of collimating optics contained in a 25.4 mm (1 inch) inner diameter polyethylene pipe.  A, interior split retaining rings.  B, SM1 rings.  C, frosted aspheric condenser lens (25 mm OD, 20 mm focal length, 600 grit).  D, #17 rubber O-ring (25.4 mm (1") outer diameter X 19.05 mm (3/4") inner diameter x 3.175 mm (1/8")). E, 25 mm magenta dichroic barrier filter. F, 25.4 mm OD plano-convex (f = 50 mm) lens.  The LED assembly will be attached to the left side of the assembly.  A metric ruler (cm) is included in the diagram to show distances.  Panel II: Retaining rings.  A, interior split retaining ring (25.4 mm (1 inch) diameter).  B, SM1 retaining ring (25.4 mm (1 inch) diameter). 





























The optical elements will be inserted inside the polyethylene tube (Figure 3).  To prevent grime and particles from adhering to the optical components, powder free gloves should be worn.  To start the assembly process, use retaining ring pliers (Tool 5) to insert a 25.4 mm (1 inch) interior retaining ring (Item 8) so it is inserted 2 mm into LED end of the tube (Figure 1).  A 25 mm diameter (1 inch) wood dowel (Tool 6) is helpful to position the retaining ring so it is set at a right angle to the tube’s axis.  The wood dowel is used to slide an SM1 retaining ring (item 9) next to the split retaining ring.  A frosted aspheric condenser lens (Item 10; 25 mm OD, 20 mm focal length, 600 grit diffuser) is inserted so the frosted side faces the LED.  A rubber O-ring (Item 11; 3.175 mm thick (1/8 inch), 25.4 mm OD diameter (1 inch)) is placed over the condenser lens.  The condenser lens is held in place by inserting a second SM1 (Item 9) retaining ring and a second 25.4 mm split retaining ring (Item 8). 

The next set of optical components consists of an excitation filter and a convex lens.  Insert a split retaining ring (Item 8) so it is 30 mm from the LED side of the tube (Figure 3).  If the tube is precisely 45 mm, the split retaining ring is inserted 14 mm into the filter side of the tube.  A dowel (Tool 6) is helpful to measure the depth of the retaining ring and position it so it is at a right angle to the tube’s axis.  Insert an SM1 retaining ring (Item 9) next to the split retaining ring.  Next, insert a 25 mm diameter magenta excitation filter (Item 12) so the dichroic coating is facing the LED.  A rubber O-ring (Item 11) is inserted and functions as a spacer to separate the excitation filter from the next lens.  A plano-convex lens (25 mm OD, f = 40 mm) (Item 13) is inserted into the tube assembly so the convex side contacts the rubber O-ring.  The lens and filter are held in place by inserting another SM1 retaining ring (Item 9) and another 25.4 mm split retaining ring (Item 8).
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Figure 4: Illumination source, calumniating optics tube, and filter cube holder. Both the dorsal view (I) and ventral view (II) of the apparatus is rotated ~70⁰ from the horizontal.  Heat sink with attached LED (A) is glued to the polyethylene tube (B) containing the calumniating optics.   The filter housing (C) is glued to the other end of the tube.  Mending plates (D) are used as rails and are fastened onto the filter housing with rivets or small screws and nuts.   The yellow bars are 1 cm size standard.
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The LED assembly is attached to the tube holding the collimating optics (Figure 4).  The LED needs to be inserted in the center to produce a uniform round beam.  One alignment strategy is to use a ring stand and clamp to hold the collimating optics tube vertically above a white sheet of paper.  Turn on the LED and insert it into the base of the calumniating optics tube.  Adjust the position of the LED until a uniform and circular beam is created on the sheet of paper.  Apply a bead of adhesive (Item 14) around the base of the tube to affix it to the LED’s heat sink.  Leave the assembly in the vertical position until the adhesive hardens.

An easier but more expensive strategy is to mount the collimating optics and excitation filter in the SM1 lens tube system sold by Thorlabs Inc. (Newton, New Jersey, USA, http://www.thorlabs.com/).  You will use the same lenses (Items 10 and 13) and dichroic filter (Item 12) as described above.   The position of these optical elements remains the same.  The SM1 retaining rings hold all the elements in place.  No interior split retaining rings are needed.  SM1 retaining rings are installed with a specialized SM1 graduated spanner wrench.  Additionally, Thorlabs sells a royal blue LED system that directly attaches to the SM1 lens tube.  Refer to the manufacturer’s catalog for details.

A hardboard frame is used to hold a 45O beam splitting dichroic filter, barrier filter and the illumination system together as a coherent unit.  Use a miter box and saw set (Tool 7) to cut out the six pieces of hardboard (Item 15) as shown in Figure 5.  Hole saws (Tools 2 and 8) are used to cut the indicated holes (Figure 4).  Assemble the hardboard (Figure 4 and Figure 5 – Boards A, B and C) to make sure the pieces fit snugly together and the sides are at right angles.  Since the 45O beam splitting filter (Item 20) is held in place mainly by friction, make sure it fits between the opposing hardboard sides (Figure 5, both Boards C).  Use sand paper on the hardboard if the pieces are too large.  Cut a new piece of hardboard if the original pieces are too small.  After the needed adjustments are made, glue together the hardboard with an appropriate adhesive (Item 14) as indicated in Figure 4.  Use a square ruler (Tool 9) or other device to make sure the hardboard pieces are adjoining at right angles.  Clamps or vices can be used to hold the pieces together until the adhesive dries.  The hard board is painted flat black (Item 16) to reduce glare.  Rails are added to the filter cube assembly so it can be inserted into a Cokin A-Series (Piktus, France) filter holder (Item 17 and 18).  Two mending plates (Item 19) are attached to the top of the filter cube assembly (Figure 4) so it protrudes 2.5 mm beyond the edge of Board A (Figure 5).  The mending plates can be fastened onto Board A with small nuts and screws or rivets.  

The beam splitting dichroic filter (Item 20) is inserted into the hardboard frame so the coated side is facing down and is at a 45O angle to the blue light beam (Figure 1).  Friction is used to hold the filter in place so its position can be readjusted as needed.  Felt strips with adhesive backing can be placed in the filter cube to help hold the dichroic filter in position.  If an adhesive is desired, use a non-permanent adhesive such as office supply rubber cement (Item 21).



[image: ]
Figure 5: Template for filter holder housing.   Hardboard, 3 mm (1/8th inch) thick, is cut to the dimension indicated.  Board A is 63.5 mm X 70 mm with a 38 mm (1 1/2 inches) diameter hole cut in the center.  Board B is 63.5 mm X 43 mm with 32 mm (1 1/4th inch) diameter hole cut off-center so the hole’s center is 19 mm from one side of the board and 24 mm to the other side.  Board C consists of two pieces of 45 mm X 43 mm hardboard. To assemble the filter holder, Board B is glued onto Board A (ventral view), 3 mm from the circular opening.  The two yellow marks should be touching and at right angles to each other.  Two pieces of Board C are glued onto Board A so they are 50 mm apart and at right angle to Boards A and B.  Board D is used to hold barrier filter holders.  Two pieces of hardboard are cut to the dimensions of 68 mm X 61 mm.  Yellow and cyan filters will be glued into the 51 mm (2 inches) diameter hole in the center of each piece.   A metric ruler is included in the diagram as a size standard.  

Frames for the circular barrier filters (Items 22 and 23) are made of hardboard too (Figure 5 Board D).  After cutting two 68 mm x 61 mm pieces of hardboard, make sure they fit snugly in the filter slots of the Cokin filter holder (Figures 1 and 6).  Cut a 51 mm (2 inches) diameter hole in the center of Board D with a hole saw (Tools 2 and 8).  To reduce glare, cover both sides of the frames with flat black paint (Item 16).  After the paint dries, apply a thin coat of adhesive (Item 14) around the inner edge of the round hole cut into Board D (Figure 5) with a tooth pick or similar applicator.  While wearing powder free gloves, insert one of the barrier filters (Items 22 or 23) into the frame.  Lay the frame flat until the adhesive dries.  Repeat the process for the second barrier filter.  


[image: ]
Figure 6: Epifluorescence camera attachment.  A Cokin A-series filter holder (red arrows) is used to connect the attachment to the camera lens.  The filter holder containing the yellow barrier filter (A) is inserted in the top filter holder slot.  The optional cyan barrier filter (B) is placed in the middle slot.  The filter cube assembly (C) is attached on the bottom slot.  The beam-splitting dichroic filter (D) is held between the sides of the filter cube assembly and is placed at a 45o angle to the blue LED light beam.  



















The illuminating system, beam splitting filter housing, and barrier filters are held as an integrated unit with a Cokin A-Series filter holder (Figure 6) (Item 17).  The apparatus is attached to a SLR camera or a dissecting microscope with a Cokin adapter ring (Item 18).  The diameters of the adapter rings range from 32 mm to 62 mm so the device will fit on most commercially made SLR cameras and many dissecting microscopes.  Slide the yellow barrier filter (Figure 6) into the topmost slot of the Cokin filter holder.  Slide the filter cube assembly into the lowermost filter slot.  The optional cyan barrier filter can be inserted between the filter cube and yellow barrier filter. 




Taking photographs with the epifluorescence attachment

Taking photographs of fluorescent objects is very similar to taking photographs of a normally illuminated object (i.e., detecting reflected light).  There are two major differences.  First, a light filter is used to prevent reflected light from entering the camera but allows fluoresced light to enter the camera (Spring, 2003).  The yellow barrier filter used in the filter cube attachment prevents the blue illumination light from entering the camera (Baker et al., 2012).  The optional cyan filter blocks red light produced by chlorophyll fluorescence but allows the green light produced by GFP fluorescence to enter the camera.  The second difference is the length of the exposure times.  Since fluorescence produces low light intensities, long exposure times are needed.   To prevent the camera from shaking, the camera is controlled with a shutter cable.  Alternatively, computer software can be used to remotely control camera functions.  The latter approach has the additional advantage of having direct download of images onto a computer’s hard drive.  To follow, is a step-by-step description on how to take high quality photographs using the filter cube.

The filter cube’s 45o beam splitting filter (Figure 1) will need adjusting before fluorescent photographs can be taken.  Attach the epifluorescence filter assembly to a fixed focal length macro-lens and attach the camera to a camera stand or stout ring stand.  Place a target object, such as a ruler, directly under the camera.  Illuminate the target object with an external white light source.  Focus the camera onto the target object, in accordance with the camera manufacturer’s procedures.  After focusing, turn off the white light and turn on the camera attachment’s LED light source.  Move the 45o beam splitting dichroic filter until the blue light beam is centered on the target’s midpoint.  Once adjusted, the objects being photographed should be evenly illuminated with the excitation light.  

All photographs should be taken where the specimen is only exposed to blue excitation light.  Photographs can be taken in a darkroom or under a light tight box. To photograph a transgenic organism’s GFP expression, place the specimen directly under the camera.  Illuminate the specimen with a white light source and focus the camera.  Turn off the white light and turn on the camera attachment’s blue LED.  Set the camera on manual exposure mode and set the camera to the desired International Standards Organization (ISO) setting, aperture setting, and exposure speed.  The exact values you should use has to be empirically derived.  Trade-offs between exposure time and image noise need to be considered.  High ISO setting allow for shorter exposure times, but sensor noise increases with increased ISO settings.  Since digital SLR cameras tend to have lower sensor noise than compact digital cameras, moderately high ISO settings, such as 1600, are acceptable.  Wide open aperture (lowest F-stop number) allows more light to hit the camera’s sensor.  Unfortunately, the resulting image will have a narrow depth of field.  Conversely, a small aperture opening (high F-stop number) will require longer exposure times which increase the effect that sensor noise has on the image.  A moderate F-stop of 8.0 works well in most situations.  Several exposure times will need to be evaluated.  The exposure time should be long enough so the fluorescence is readily visible, but short enough so the sensor’s pixels are not saturated.  For a detailed discussion see Baker et al. (2012).  A good procedure is to take test photographs with the experiment’s positive controls, such as transgenic plants whose GFP expression is under the control of the cauliflower mosaic virus 35S (CaMV 35S) promoter.  Set the camera to an ISO of 1600 and an F-stop of 8.0.  Take a 1.0 s exposure.  Evaluate the image on the camera’s liquid crystal display monitor.   If the image is too dark, increase the exposure time.  If the image is too bright, reduce the exposure time.  Repeat the process until an acceptable exposure time had been determined.  Use this exposure time for all subsequent photographs.


Image files

ImageJ is powerful software created by the National Institutes of Health (NIH) to support the research community in medical image analysis (Rasband, 2013).  The software is written in Java.  As a result, it runs on multiple operating systems such as Windows, Apple OS, and Linux.  Because the software is open source, hundreds of plug-ins have been created that expand its capabilities.  Unfortunately, some of the plug-ins do not use a Java compiler and only work with specific operating systems (Coffin, 2014).

In this laboratory investigation students will use ImageJ to quantify relative light intensity.  As a result, the students will be using digital SLR cameras as a quantitative instruments.  Most consumer cameras store images as Joint Photographic Expert Group (JPG) files.  Though JPG files can be read by many software packages, they are not appropriate for fluorescence image analysis.  JPG files are gamma corrected which results in the light intensity information being stored on a logarithmic scale (McHugh, 2013).  To reduce file sizes, JPG are lossy compressed.  Unfortunately, lossy compression reduces file size by eliminating pixel information (Ferreira and Rasband, 2012).   File formats other than JPG should be used in scientific digital photography.

Raw files are the best format to store digital images because they contain the pixel data captured by the camera’s sensor before image processing.  Raw files can be thought of as the digital equivalent of a photographic negative.  Unfortunately, raw files are camera specific.  Thus, specialized software is needed to access the data.  Two approaches can be used to access raw file data.   The first is to use software that can directly read raw files.  Fortunately, ImageJ has a plug-in, DCRaw Reader, that can access the raw files produced by 580 models of digital cameras (Coffin, 2014).  The second is to convert raw files into linear Tagged Image File Format (TIFF) files.  Most digital SLR camera manufacturers provide this function in their image management packages.  There are third party software packages that will do this as well.  Refer to the software manual for directions.  Make sure to choose the linear option when creating the TIFF files because most software has gamma correction as the default setting.  The disadvantage of TIFF files is that the conversion process is time consuming.  Thus, using the DCRaw Reader plug-in greatly speeds the process of data acquisition in a classroom setting.





Installing ImageJ and the DCRaw Reader plug-in
[bookmark: h.1fob9te]A three step process is needed to create a functional copy of ImageJ with the DCRaw Reader plug-in.  First, download a version of ImageJ corresponding to your computer’s operating system.  They can be downloaded at http://rsbweb.nih.gov/ij/download.html (Rasband, 2013).  Choose a package that has a built-in Java compiler.  Download the package and the corresponding installation instructions.  Additional instillation instructions can be found in the ImageJ User Guide (Ferreira and Rasband, 2012).  A current user guide will always be posted on NIH’s the web site at http://imagej.nih.gov/ij/docs/guide/.  Run the instillation utility downloaded from NIH’s web site.  If you use the default settings, the program will be installed within the following Windows directory: Local Disk (C:)\Program Files\ImageJ (file directory names are in bold type).  After installing ImageJ, start the program by clicking the ImageJ icon that looks like a microscope.

[bookmark: h.3znysh7]The second step involves downloading the version of the DCRaw Reader plug-in that is compatible with your computer’s operating system.  For Macintosh computers, download the Linux jar file from Source Forge and the Macintosh executable file from Pukkita's Digital Darkroom Corner at http://www.insflug.org/raw/Downloads/  (Montilla, 2013).  For detailed instructions see the ImageJ Documentation Wiki  (Sacha, 2012).  To start the download process with the Windows operating system, create a directory on the hard drive in a location you can easily access and give it a convenient name such as “DCRaw”.  Download the plug-in from Source Forge at http://ij-plugins.sourceforge.net/plugins/dcraw/ (Sacha, 2014).  Choose the DCRaw Reader version corresponding to your operating system and download it into the newly created directory.  In my hands, some combinations of ImageJ and DCRaw Reader are not compatible.  I have found ImageJ 1.47v works well with DCRaw Reader v1.3.0.

The third step involves inserting the plug-ins into ImageJ.  Instructions for Macintosh computers are presented in the ImageJ Documentation Wiki (Sacha, 2012).  The following instructions are for Window’s based computers.  Source Forge files are downloaded in ZIP files.  Use a ZIP utility to extract the files.  Once extracted there will be two sets of materials that need to be inserted: a file called ij-dcraw_.jar and a directory called dcraw (which contains the files cygwin1.dll and dcraw.exe).  Insert the Java archive (JAR) file and the dcraw directory into the ImageJ plugins directory by following the path Start > Computer > Local Drive (C:) > Program Files > ImageJ > plugins.  The contents of the ImageJ plugins directory after the DCRaw Reader has been installed are shown in Figure 7. 



[image: ]Figure 7:  ImageJ plugins directory after instillation of DCRaw Reader.  The items inserted from the DCRaw Reader plugin are highlighted in blue.















To test the software installation, launch ImageJ.  To access DCRaw Reader follow the path Plugins > Input-Output > DCRaw Reader.  If an “Open” dialog box starts, the software has been installed correctly.  If an error message occurs, either the executable file, the DLL file or the JAR file has not been installed in the correct location.  If this has occurred, the best option is to reinstall the software.  First delete the ImageJ directory by following the path: Start > Computer > Local Disk (C:) > Program Files > ImageJ.  Repeat the second and third steps as described above. 


Distributing software

Because the instillation process for ImageJ - DCRaw Reader involves multiple steps, I would not recommend having students installing the software from the NIH and Source Forge web sites.  I have been successful in distributing the software by two different methods.  The first method involves copying the ImageJ directory from a functioning copy of ImageJ onto a USB flash drive or CD-ROM.  The software is distributed by copying the stored ImageJ directory into the student’s Program Files directory.   After copying the software, an ImageJ icon needs to be sent to the desktop of the student’s computer.  Go to the ImageJ directory by following the path: Start > Computer > Local Disk(C:) > Program Files > ImageJ.   Within the ImageJ directory there should be a microscope icon labeled ImageJ.  Right-click the icon and follow the path: Send to > Desktop (create shortcut).

The second method involves distributing ZIP files over the Internet.  Use a ZIP file utility to make a ZIP file containing the ImageJ directory and all of its sub-directories.  The ZIP file can be uploaded onto a course web site.  The students then download the ZIP file onto their computers and extract the ZIP file within their Program Files directory.  The students then make a desktop icon as described above. 
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Procedure and general instructions (for students).

Measuring Green Fluorescent Protein Expression with ImageJ
By Stokes S. Baker, MS, PhD
Associate Professor of Biology
University of Detroit Mercy

Introduction

You will be taking measurements of the protein expression from the green fluorescent protein reporter gene (gfp).  The measurements will be taken from digital photographs of fluorescing plants.  Fluorescence is the production of long wavelength light particles (photons) made by molecules that have absorbed light with a shorter wavelength.  To produce fluorescence, shorter wavelength light, known as the excitation light, is used to illuminate the object.  To observe fluorescence, excitation light needs to be blocked from entering the camera because fluoresced light is dimmer than the excitation light.  This can be accomplished with a barrier light filter.  In your experiments, you will be taking fluorescent photographs using an epifluorescence camera attachment (Figure 1).   The technique of epifluorescence involves the use of specialized light filters known as dichroic filters.  Unlike most light filters which absorb specific wavelengths of light, dichroic filters reflect specific wavelengths of light.  As a result, they can be used as a beam splitter when they are placed at a 45o angle from the light source.  The short wave excitation light that is produced by blue light emitting diode (LED) is reflected at a right angle and illuminates the specimen.  The light that is reflected from the specimen cannot enter the camera because the dichroic filters reflect the light away from the camera.  Fluoresced light, which has a longer wave length than the excitation light, passes through the dichroic filters and enters the camera.  With the epifluorescence attachment, you will be able to use a digital camera to measure the amount of surface fluorescence produced by green fluorescent protein. 

The digital images will be analyzed using the computer program ImageJ.  This software was created by the National Institutes of Health for medical image analysis.  The software is written in Java, which means it will run on many types of computers, as long as the computer has a Java compiler.  Because the software was created by a branch of the United States federal government, it is provided to individuals free of charge.  Your instructor will provide you with a copy of the software or arrange other access to the program.  


Using ImageJ:

To launch ImageJ, follow the Windows operating system path Start > All Programs > ImageJ > ImageJ or click the ImageJ microscope icon on the Windows desktop.  When ImageJ is activated, the ImageJ dialog box (Figure 2) will appear.  The dialog box can be moved around the screen by placing the mouse cursor over the top blue ribbon of the ImageJ dialog box, click-and-hold the mouse, and dragging the dialog box to the desired location.  

[image: ]Figure 1:  Digital single lens reflex (SLR) camera with epifluorescence attachment.  Light from a blue light emitting diode (LED) (A) passes through condensing lenses and an excitation filter (B).  A 45O dichroic beam splitting filter (C) reflects blue light (blue down arrow) onto the specimen and allows contaminating green light (green dashed arrow) to pass through.  The blue light reflecting off the specimen (blue dashed arrow) is blocked by a combination of the beam splitting filter (C) and a yellow barrier filter (E).  Red light from chlorophyll fluorescence (red dashed arrow) can be blocked if a cyan filter (D) is included with the barrier filter set.  Green light produced by green fluorescent protein fluorescence (solid green arrow) passes through the beam splitting filter (C) and both barrier filters (D and E) and enters the camera.
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Figure 2: Dialog box for ImageJ 1.47v.  The first row of the dialog box is the menu bar.  The quick access bar is the row of buttons below the menu bar.  The names of the quick access buttons are labeled in yellow.


Because this software is used by a large and active scientific community, new versions of the software are released periodically.  The instructions described below are for ImageJ 1.47v.  The steps used to analyze images may change with different versions of the software. To determine the version of ImageJ you are using, start ImageJ by following the path Start > All Programs > ImageJ > ImageJ or click the ImageJ microscope icon on the computer’s desktop.  Once ImageJ is launched (Figure 2), follow the path Help > About ImageJ.  The resulting dialog box will provide information regarding the software, including software version.


Types of image files:

Digital images are usually stored as compressed files which require less disk storage space.  One of the most common image formats is the Joint Photographic Expert Group (JPG) file.  JPG files can be used by a wide range of software like Internet browsers (e.g., Internet Explorer) and word processors (e.g., MS Word). Unfortunately, JPG files use lossy compression which means data is lost when the file is compressed.  Additionally, to present the image in a manner reflecting the way the human eye perceives light intensity, JPG files store light intensity information in a logarithmic scale, a process known as gamma correction.  To take accurate measurements from a digital camera you will be working with raw files instead of JPG files.  Raw files are the files made by digital cameras before they are converted to JPG files.    Unfortunately, digital cameras use a number of different files formats; thus, specialized software will be needed to open and view raw files.


ImageJ plug-ins:

ImageJ is very flexible software because a number of smaller programs, known as plug-ins, have been written to provide a number of specialized functions.   They are accessed by clicking the Plugins option on the ImageJ menu bar (Figure 2).  The plug-in you will be using is named DCRaw Reader.  This plug-in can read raw files from over 500 models of digital cameras.  The instructions below are for DCRaw Reader version 1.3.0.  To determine what version of DCRaw you are using, launch ImageJ, then follow the path Help > About Plugins > About DCRaw Reader.


Opening RAW files:

To activate the DCRaw Reader plug-in, follow the path Plugins > Input/Output > DCRaw Reader.  When the “Open” dialog box appears, a list of image files will be presented (Figure 3).   Do not open the preview icons showing a color image.  Color preview icons are not produced from the raw files.  Raw file icons are shown as a camera shutter.  Raw files created by Cannon digital cameras will have the extension CR2 or CRW.  Nikon’s raw files have the extensions NEF or NRW.  Other camera brands will have their own unique file extensions.  Click the raw file icon corresponding to the photograph of interest.  Click the “Open” button.
The next step is to tell the software how to record spectral information and light intensity (Figure 4).  When the DCRaw Reader dialog box opens, click the “Use temporary directory for processing” box, then click the “White balance” pull-down window and choose “None.” Click the “Read as” pull-down window and choose “16 bit linear”, and click the “Interpolation quality” pull-down menu and choose “Adaptive Homogeneity-Directed (AHD)”.  After the “OK” button is clicked, an image will appear (Figure 5).

[image: ]
Figure 3: ImageJ “Open” dialog box.  The raw file in this example has CR2 extensions.  The icon next the CR2 file is the color preview image of the corresponding JPG file.
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Figure 4: DCRaw Reader (version 1.3.0) dialog box.  The setting shown (i.e., White balance, None; Output colorspace, 0 – raw; Read as, 16-bit linear; Interpolation quality, 
3 – Adaptive Homogeneity-Directed (AHD)) are the ones used to analyze fluorescence.
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Figure 5: ImageJ DCRaw Reader image dialog box and Brightness and Contrast dialog box.  The color channels (red, green and blue) are switched by moving the slider bar on the bottom of the image dialog box (Panel A).  The image brightness and contrast can be adjusted by clicking the “Auto” button or moving the “Brightness” and “Contrast” slider bars within the B&C dialog box (Panel B).









The image within the image dialog box may appear dark because the file is being opened without gamma correction or white balance.  To make the image easier to see, you can change the brightness and contrast in the red channel, green channel, or the blue channel. The changes made do not alter the pixel information of the RAW file.  The changes are made only to the activated color channel.  To make adjustments to the other color channels, move the slider bar on the bottom of the image dialog box (Figure 5A) to the desired position.  When the slider bar is to the left, the red channel is activated.  The slider bar placed in the center activates the green channel.  Placing the slider bar to the right activates the blue channel.   Since GFP fluoresces green, the image dialog box slider bar (Figure 5A) should be placed to the center.  

To change the image contrast or brightness, activate the B&C dialog box by following the path in the ImageJ dialog box (Figure 2)  Image > Adjust > Brightness/Contrast.  The B&C dialog box (Figure 5B) is used to change the brightness and contrast of the computer screen image.  Use the “Auto” button or the slider bars in the B&C dialog box to make the desired adjustments.  

The size of the objects within the image dialog box can be increased or decreased.  To change the size of the objects, click the magnify tool (Figure 2), place the mouse over the image dialog box and left-click the image.  The image gets larger every time you left-click the mouse.  To make the image smaller, right-click the mouse.  The image can also be increased by pressing control and the plus key (Ctrl +).  The image can be made smaller by pressing the control and minus keys (Ctrl -).  The image within the image dialog box (Figure 5A) can be moved around by clicking the “Scrolling tool” (hand symbol in Figure 2).  Once activated, move the curser over the image, left-click-and-hold and move the hand symbol around with the mouse.

Making image measurements:

ImageJ can measure many digital image attributes, such as the size of structures and the distance between objects.  Since photographs can be taken at any magnification, calibration with a size standard is required.  Measurements should be recorded in metric units.  In this exercise you will be measuring the number of scintillations observed by the camera sensor’s pixels.  Thus, the software’s scale and measurement settings need to be altered from the default values.  Take a photograph of a size standard such as a metric ruler using the same setup as you are using to photograph the fluorescent plants.  Open the size standard image using DCRaw-Reader (see above).  Click the Distance tool (Figure 6A).  Use the mouse pointer and draw a line across the size standard (Figure 6B).  Launch the Set Scale dialog box by following the path (Figure 6A) Analyze > Set Scale.   After the dialog box appears (Figure 6C) remove the default calibration by clicking the Click to Remove Scale button.  Type in the distance in the “Known Distance” box.  In the “Unit of Length” box, type in the appropriate metric unit.  Click the Global box (Figure 6C).  When the Global box is checked, the scale setting will be kept when another image file is opened.  Close the dialog box by clicking the OK button.



[image: ]


Figure 6: Dialog boxes used to calibrate ImageJ to standard metric units.  Panel A: The base ImageJ dialog box with the Distance tool clicked.  Panel B: A photograph of a metric ruler taken with the same camera assembly used to photograph the fluorescent plants.  The yellow line was drawn using the Distance tool.  Panel C:  The Set Scale dialog box with the “Known Distance” and “Unit of Length” values entered.  The “Global” box is activated.


















The measurements made by ImageJ are controlled by the “Set Measurements” dialog box (Figure 7).  To activate start with the main ImageJ dialog box (Figure 6A) and follow the path Analyze > Set measurements.  Click the Area box, Mean gray value box, Stack position box, Display label box and the OK box (Figure 7).  The Area box has the software measure the number of pixels in a defined area.  Mean gray value box has the software record the mean (average) number of scintillations (i.e., light flashes) recorded by each pixel within a defined area.  The Stack position button has the software record the color channel (red, green or blue) being measured.  The Display label button has the file name recorded with each measurement.

Figure 7: Set Measurements dialog box.  The Area box has ImageJ determine the area within a defined region.  The Mean gray value box has ImageJ measure the average intensity within a defined region.  The Stack position box has image record the color channel being measured.  The Display label box has the image file title recorded with each measurement.
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ImageJ has a series Region of Interest (ROI) tools that are used to define what segment within a photograph will be analyzed.  The ROI tools are the first seven buttons shown in Figure 2.  Additional tools, like the image scrolling tool and the magnification tool are also shown.  To make a measurement, click the desired ROI tool.  Use the mouse to place the pointer over the region you want to measure, then left-click-hold and drag to define the ROI.  In Figure 8 the oval tool was used to define a leaf region that was fluorescing.
[image: ]
Figure 8: Defining the Region of Interest (ROI).  In this example, the oval tool (Panel A) was used to define the region containing a fluorescing leaf fragment.  The ROI are the pixels inside the yellow oval (Panel B).  The following information appears when the Analyze  Measure function is used (Panel C): first column is sequence in which the measurements were taken; “Label” column is the file name and panel color of the ROI; “Area” column is the number of pixels within the ROI; “Mean” column is the average pixel intensity as measured as the number of photons detected (counts/pixel); “Ch” is the color channel in which the ROI measurement was taken.  Channel 1 corresponds to red pixels, Channel 2 corresponds to green pixels, and Channel 3 corresponds to blue pixels.







































To make a measurement within the ROI, follow the path Analyze → Measure.  Figure 8C shows a typical set of measurements.  The first column of the “Results” box is a measurement counter.  Since this is the first measurement, the value “1” is shown.  The column labeled “Label” shows the file name and the color panel from which the measurement was taken.  The column labeled “area” is the number of pixels in the ROI.  The column labeled “Mean” is the average intensity of a pixel within the ROI.  Since this is a measure of intensity, this is the value you should record.  To make more measurements within the image, define the next ROI and follow the path Analyze → Measure. Continue this process until all the measurements within the image have been made.  Record the “Mean” values of your measurements, or save the data file on a flash drive by following the path File → Save as. 


Calculations:

To determine if the differences in the intensity of the treatment and controls are statistically significant, you need to calculate the averages of the intensities (i.e., “Mean”), and calculate the 95% confidence intervals.  Remember, if the 95% confidence intervals do not overlap, then the differences in the intensities are statistically significant.   In your laboratory reports or posters, you can graphically present the data as means with 95% confidence interval range bars.  An example of such a graph is presented below (Figure 9).  In the example presented, the difference in mean light intensity between the control plants (wild type) and plants heterozygous for the GFP reporter gene is statistically significant.  The mean difference between the heterozygous plants and homozygous plants is statistically significant as well.

Panel A:                                                                         Panel B
[image: ]

Figure 9: Example of light intensity data analysis.  Panel A: Table showing pixel intensity statistical calculations.  Panel B: Bar graph showing gene fluorescence measurements from wild type plants and plants heterozygous for the GFP gene and homozygous for the GFP gene.  Range bars are 95% confidence intervals.
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Student assignments related to the activity

Plant Stress Acclimation:
A System for Student Designed Experimentation
By: Stokes S. Baker, Ph.D.
Biology Department, University of Detroit Mercy

Introduction
[image: ]
Figure 1: 
A life size photograph of Arabidopsis thaliana.  
Photographed by S.S.Baker.

	Acclimation is the process where changes in physiology allow organisms to prepare for a stress.  Plants have evolved many interdependent acclimation systems to survive biotic and abiotic stresses because, unlike animals, they cannot move away from stress.  One abiotic stress that has driven plant evolution is dehydration.

[bookmark: h.2xcytpi]	Arabidopsis thaliana (arabidopsis or mouse ear cress) is the favorite organism for many experimental botanists because it has a rapid life cycle (six to eight weeks to go from seed to seed), is small (Figure 1) and has well understood genetics.  It grows well indoors, both in soil and in Petri dishes. Procedures for growing arabidopsis can be found at ftp://ftp.arabidopsis.org/Protocols/PREP_handbook/6-Appendices.pdf.  The plant is prolific. One individual can produce tens of thousands of seeds.  As a result, this plant has become the “fruit fly” of the plant world.   In fact, every nucleotide in its genome has been sequenced.  For more information about this plant go to The Arabidopsis Information Resource Center (TAIR) web site at http://www.arabidopsis.org/portals/education/aboutarabidopsis.jsp.

	Drought can kill plants because of dehydration.  Molecular studies have shown that many changes in gene expression occur when plants are dehydrated.  Presumably, some of these changes in gene expression help plants acclimate.  Engineered A. thaliana lines that express increased levels of dehydration gene products show increased drought resistance (Zhang et al., 2004).

	To interpret results from genetic engineering experiments, you need to understand the structure of eukaryotic structural genes.  Protein encoding genes consist of three major regions (Figure 2).  The "beginning" of the gene is known as the promoter.  Promoters contain a variety of sequence elements that determine when and where a gene will be transcribed.  The transcribed region is the DNA sequence that is the template to make RNA.  Within the transcribed region is the coding region of the gene that determines the protein sequence when mRNA is made and translated.  The "end" of the gene is the terminator, a DNA sequence that stops transcription.

Promoter
Transcribed region
Terminator
Figure 2:  A simplified diagram of the structure of a eukaryotic gene that encodes a protein.  



Genetic engineering involves using recombinant DNA technology to create new genes.  One way to do this is to create a chimeric gene, a gene that is made by splicing together the promoter, coding region, and terminator of different genes that results in the formation of a new functional gene. An example of a chimeric gene is shown in Figure 3.


Figure 3:  Structure of a cold inducible chimeric gene.  The promoter region of the Arabidopsis thaliana drought inducible gene drought2 (drt2) was inserted in front of the coding region of green fluorescent protein (GFP) using recombinant DNA technology.  The transcription termination signal is encoded from the Agrobacterium NOS gene.


drt2-promoter

GFP (green fluorescent protein) coding region

NOS-ter
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Chimeric genes made with dehydration inducible promoters

In this laboratory you will be working with a chimeric gene containing dehydration inducible promoters.  The promoter come from the drought-induced Arabidopsis genes, drought2 (drt2).  This promoters have been used to make chimeric reporter gene.  Reporter genes are sequences that encode easily detectable proteins, thus “reporting” the induction of transcription.   Thus, you can assay the transcription pattern of the promoter by viewing the expression pattern of the resulting protein.  You will be working with the gfp reporter gene (Figure 3).








The gfp Reporter Gene[image: ]Figure 4: GFP and chlorophyll fluorescence in Arabidopsis leaves.  Panel A: Wild type leaf viewed under white light (chlorophyll reflection).  Panel B: Wild type illuminated with visible blue light and viewed through an orange filter (chlorophyll fluorescence).  Panel C: Wild type leaf illuminated with visible blue epifluorescence lighting as in Figure 5.  Panel D: Transgenic plant expressing GFP illuminated as in Panel C.  Photos by Haittam Greib (Panels A & B) and Cleo Vidican (Panels C & D).




The gfp reporter gene encodes green fluorescent protein (GFP).  (Note: One common convention to distinguish the gene from the encoded protein is to designate the gene in italics and to designate the corresponding protein in capital letters.)  The gene was originally isolated from Aequorea victoria, a bioluminescent jellyfish.  The version of GFP you will be working with produces green fluorescence (Figure 4D) when the protein is illuminated with visible blue light. Unfortunately, chlorophyll fluoresces red when illuminated with blue light as well (Figure 4B).  Therefore, the best way to see green fluorescence is to use an epifluorescence light filter system (Figure 5) that prevents blue light and red light from entering the camera.  The resulting leaf image is dark (Figure 4C) unless GFP is present (Figure 4D).


Detecting GFP in A. thaliana:
1. Place plant samples under a camera having a 100 mm macro lens attached to a royal blue light emitting diode epifluorescence GFP filter cube (Figure 5).Figure 5: An epifluorescence filter cube attached to a digital camera.  Blue light from a light emitting diode (A) passes through an excitation filter (B) into a filter cube.  A beam splitting 45o dichroic filter (C) reflects blue light onto the specimen.  Fluorescent green light from GFP passes through filters (C, D and E) into the camera.

[image: ]

2. Focus lens while under white light illumination.
3. Turn off white light and remove extraneous background lighting (i.e., close door to light tight box.)
4. Photograph image for 0.5 to 2.5 seconds.
5. Transfer digital image to a computer.
6. View image with software.  RAW image files can be quantified with ImageJ software (see separate handout).

Detecting dehydration induced expression of chimeric genes
You will detect dehydration induced expression of drt2/gfp plants by excising leaves from plants.  When leaves are removed from the plant, they will desiccate (lose water) due to transpiration (water vapor loss through the stomata [leaf pores]).  After a period of time, the chimeric gene will be induced.  An example of the results you might obtain from the leaf excision experiment is shown in Figure 6.

Procedure:[image: ]Figure 6:  A leaf dehydration stress experiment with transgenic A. thaliana containing drt2/GFP.  Columns represent light conditions for photograph.  Top row are control leaves either not expression GFP (wild type) or continuously expression GFP (GFP+).  The bottom row is from a leaf expressing drt2/GFP before (0 min.) and after (130 min.) dehydration stress.


1. Use scissors to remove one or two leaves from each of the following types of plants: wild type (normal), transgenic containing the 35S/gfp chimeric gene, and transgenic containing the drt2-gfp chimeric gene.  The wild type plant is your negative control because it does not express GFP.  The transgenic 35S/gfp plant is your positive control because the 35S promoter confers continuous (i.e., constitutive) expression.  Your treatment is from the plant containing the drt2-gfp gene.

2. To demonstrate that the drt2-promoter is not being expressed, immediately place some of each type of leaf (wild type, drt2-chimeric, 35S-chimeric) into in the reporter gene detection system (Figure 5).  After taking the photograph, place the excised leaves out onto the laboratory bench.  The leaves will desiccate.

3. One to two hours later, place each type of leaf into the reporter gene detection system (Figure 5).
	

Calculations
Spreadsheet software, like Microsoft Excel, can be used to perform calculations.  The data files are stored in a generic format so many different brands of spreadsheet software can access the data.  If you use Excel to open the ImageJ data file, you will need to respond to a series of prompts by clicking the “next” buttons.
Convert all of your intensity measurements to the unit counts/pixel/s. To determine if the differences in the intensity of the treatment and controls are statistically significant, you need to calculate the averages of the intensities (i.e., “Mean”), and calculate the 95% confidence intervals.  Remember, if the 95% confidence intervals do not overlap, then the differences in the intensities are statistically significant.   In your laboratory reports or posters, you can graphically present the data as means with 95% confidence interval range bars.  An example of the calculation and graph is shown on the right (Table 1 and Figure 7).  The induction of drt2/gfp by excising leaf fragments should be statistically significant.  There should be no statistically significant differences before and after leaf dehydration in the negative control (wild type) and positive control (35S/gfp) leaves.[image: ]Figure 7:  Effect of leaf dehydration on expression of the chimeric drought2/GFP gene.  Control plants are wild type (no GFP) and 35S/gfp (constitutive GFP).  Range bars are 95% confidence intervals.

Table 1: Measurements of green light fluorescent levels of before and after leaf dehydration.  Values recorded are mean pixel intensity (counts/seconds).  Statistical calculations are shown below. [image: ]
 












Your Assignment
During the next few weeks, you and your table partners will be jointly performing experiments with transgenic Arabidopsis that express the chimeric drt2-reporter gene.  You will be investigating the following question:
· Is expression of drt2 specific to dehydration or is it induced by multiple stresses?



To answer this question you will be performing the following activities:

1. Perform the leaf dehydration experiment described above, using an Arabidopsis thaliana line containing a chimeric drt2/gfp construction.  Make sure to include negative controls (leaves from wild type plants) and positive controls (leaves from 35S/gfp plants).

2. As a group, decide what type of stress, in addition to dehydration, you will be investigating.  Each group will be required to investigate a different stress.  You will have access to the resources you have seen in the laboratory (e.g., salt, ionic copper, lights, light meter, pH paper, buffers, small pans, warm temperature (37 oC) incubator, etc.).  You will need to have your investigation topic approved by the instructor.

a. To quantify the level of damage caused by your chosen stressor, you will measure the growth of stressed and non-stressed plants.   You will need to measure the change in height of 10 or more plants and calculate 95% confidence intervals.  You should be able to see growth of your plants over a seven day time span.

b. Normally A. thaliana is grown under fluorescent lights (100 to 150 μE/m2/sec)[footnoteRef:2] at room temperature. [2:  An Einstein is a mole of photons. A micro-Einstein can be abbreviated as μE.] 


3.  Your group will need to turn in a written research proposal.
a. Make sure to schedule a time for your group to plan the proposal before leaving class.  Email, discussion boards and cloud-based survices are great mechanisms to work on a joint document.

b. To be able to interpret your experimental results, you will need to know some background information.  Therefore, you should perform some library/internet research to find information that is related to your experiment.

c. Hand in the formal written proposal for critique by the professor at the next laboratory period.  Address the following issues in your one to two (1 to 2) page proposal.

i. What issue is being addressed?  What is your hypothesis?

ii. Describe the experiment.  
· What variable will be altered?
· What will be your controls?
· Describe your experimental methods.  A diagram of the experimental apparatus may be required.
· Describe how you will quantify your results. 
· Describe the statistical analysis that will be performed.
iii. Describe the possible outcomes and discuss their meanings.
 
iv. Once your proposal has been approved, perform your proposed experiment. 
NOTE 1: Once you have started your experiment, it will be your responsibility to take care of your plants.
NOTE 2: Since several students will be performing experiments at the same time, all materials must be labeled with the following information: Group's name, course section, treatment, date.

4.  Write a formal scientific poster describing the results of your experiment.  
a.   Instructions on how to write your scientific poster will provided in a separate handout.
b.   Make sure to include the results of the initial dehydration experiments in the poster.  Include the results of the statistical analysis.


Literature Cited

ZHANG, J. Z., R. A. CREELMAN, AND J.-K. ZHU. 2004. From Laboratory to Field. Using Information from Arabidopsis to Engineer Salt, Cold, and Drought Tolerance in Crops. Plant Physiology 135: 615-621.

[bookmark: h.1ci93xb][bookmark: OLE_LINK1][bookmark: OLE_LINK2]
OPTIONAL SECTIONS

Proposal Checklist

Instructions: Your short research proposal should contain the following items.

□ List the members of your group	
□ State your group’s name

Is expression of drought2 specific to dehydration or is it induced by multiple stresses?

□ Describe the stress (other than withholding water) you plan to investigate.

□ State your hypothesis.
 This can be done as an “If . . . then . . .” statement.
□ Describe the experiment to be conducted.  An apparatus diagram may be required.
□ Describe the variable to be altered.
□ Describe the controls needed.
	□ Negative control needed?  Describe.
	□ Positive control needed?  Describe.
□ Describe how you will quantify your results. 
□ How will you measure stress?
□ Describe the statistical analysis that will be performed.

□ Describe the possible outcomes and discuss their meanings.


Note: You need to include literature cited section.




Creating a Scientific Mini-Poster and Grading Rubric

I. The title is a declarative statement of the main conclusion of your poster.  (2 points).

II. Introduction: (5 points)
A. Places issue into larger context.  [Transcriptional gene regulation is involved with acclimation]
B. Provides the pertinent background information to the reader.  Cite sources.
- Describe Arabidopsis drought-2 (drt2) gene
- Describe drt2/gfp (Green Fluorescent Protein) chimeric reporter gene
C. States the hypothesis being tested or describes the issue being investigated.  [Determine specificity of drt2 promoter to stress stimuli.]

III. Materials and Methods: (10 points)
This section describes procedures in enough detail so another investigation can interpret the data. This section is written as a narrative, not as a list of steps.
A. Provides a description of the unique materials used in the experiment (like species of plant, genetics, etc.).  
           1. Used Arabidopsis thaliana.  Transgenic plants contained chimeric gene 35S/gfp (always expressed so a positive control) and drt2/gfp.
B. Describes the procedures used.  In posters, procedures are often presented as a flow chart, with pictures added to help the reader visualize the process.  
           1. If an unusual apparatus was used, a diagram might be included. [Do not photograph the epifluorescence camera.  Describe YOUR experiment.]
C. You may simply cite the sources describing the procedures and calculations used instead of writing them out at length.  
       1. For the epifluorescence camera, cite the paper Baker et al. (2012).
 2. Note: The sentences are written in the past tense. You are writing the report after the experiments were completed.

Baker, S.S., C.B. Vidican, D. Cameron, H. Greib, C.C. Jarocki, A.W. Setaputri, C. Spicuzza. 2012.  An epifluorescent attachment improves whole plant digital photograph of Arabidopsis thaliana expressing red-shifted green fluorescent protein. AoB Plants DIO:10.1093/aobpla/pls003.


IV. Results: (6 points)
In posters, the results section is often presented just as figures and tables.
A.  Figures include diagrams, graphs, and photographs.  
1.  They are presented in the order they will be presented in the Discussion section.
2. Figures should clearly present information.
3. Appropriate statistics are presented.
4. Figure statements (captions under the figures) that are complete, and provide enough information for interpretation of data without referring to the text. They are numbered consecutively with Arabic numerals.
5. Raw data used to create figures are not included in the results.

B. Tables are not figures, they are tables. Tables are number consecutively with Roman numerals.  The table’s written information provides the same information as a figure statement, except the table number and title are on top of the table. The rest of the table statement is written under the table. 

V. Discussion:  (15 points)
The discussion is the most important part of the report.
A.  The meaning of the data is concisely discussed. This is not a statement of the results.  It is a discussion of the meaning of the results.  
1. Make specific references to each figure and table in the order presented in the results section.  
2. Make specific comparisons between treatments and controls in your analysis. 
3. State if the differences between treatments and controls are statistically significant.

B. Relate your results to the proposed hypothesis presented in the introduction. (Is drt2 promoter induction specific to dehydration or is it induced by other stresses?)

C.  Assess the strengths and weaknesses of your study. Do not conceal “bad” data. Instead, explain what is inconsistent in the observation. Propose an explanation of why your data is weak and how the problem can be corrected.

D.   Relate observation to the scientific literature.  Cite your sources.


VI. Literature Cited: (5 points)
A.  List each cited work, in alphabetical order by author’s last name.
[bookmark: h.3whwml4]B.  Use the Council Science Editors (CSE) format when citing the literature.  CSE is different than MLA or APA.  A detailed description of CBE citation can be found at: http://writing.colostate.edu/guides/researchsources/documentation/cbe_name/.  An online tool to create CSE formatted citations can be found at http://www.lib.ncsu.edu/citationbuilder/ and at https://21cif.com/tools/citation/cse/citeWizard_cse_1.0.html. 




VII. Citing Sources: 

The citation most often used in science involves using the author’s last name and date of publication. Examples:

JPG files use lossy compression (Cromey 2006) . . . [single author]
The soil extraction method of Sills and Niehuis (1995) was used . . . [two authors]
Several economic systems reward pollution (Raven et al. 1994) . . . [more than two authors; et al. is a Latin abbreviation for “and others”]

VIII. General information: (7 points)
A. Type onto a single 8.5” by 11” paper, using 10 point or 12 point font.  Margins can be as small as 0.25 inches.  You can type the text by word processor and glue the printout onto your poster or you can create your poster as a Power Point slide.  

B. Diagrams and graphs can be made by hand then photo-reduced to fit onto the page.   Alternately, graphs and diagrams can be made with computer software.  Make sure all elements are legible after photo-reduction.

C. You are not required to use color prints, though color is permitted.  If you are using black-and-white reproduction, make sure the text descriptions are compatible with black-and-white figures.

D.  Use proper grammar and spelling.

E.  Never use contractions.

F.  Latin terms and scientific names of organisms are written in italics. The scientific name of an organism has two parts, the genus name and the species name. The genus name is capitalized, but the species name is not. For example, the correct way to write the scientific name for humans is Homo sapiens.

G. Use metric units of measures (oC not oF, cm not inches)

H.  Spell out acronyms the first time used. (e.g., Green fluorescent protein (GFP) was used . . .)

I.  Cite all information from other sources.

J. The Materials and Methods section and Results section are written in past tense.

K. Write in the third person, objective voice.  Never use the words “I” or “we”.  Example: “The experiment was performed” rather than “I performed the experiment.” 



[image: Example Poster]Example of good scientific mini-poster:
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Figure 7: ImageJ plugins directory 

after instillation of DCRaw 

Reader. The items inserted for the 

DCRaw Reader plugin are 

highlighted in blue.
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Figure 1:  Digital single lens reflex (SRL) 

camera with epifluorescence attachment.  

Light from a blue light emitting diode (LED) 

(A) passes through condensing lenses and 

an excitation filter (B).  A 45

o

dichroic beam 

splitting filter (C) reflects blue light (blue 

down arrow) onto the specimen and allows 

contaminating green (green dashed arrow) 

to pass through. Blue light reflecting off the 

specimen (blue dashed arrow) is blocked by 

a combination of the beam splitting filter 

(C) and a yellow barrier filter (E). Red light 

from chlorophyll fluoresces (red dashed 

arrow) can be blocked if a cyan barrier filter 

(D) is included with the barrier filters.  

Green light produced by green fluorescent 

protein fluorescence (solid green arrow) 

passes through the beam splitting filter (C) 

and both barrier filters (D and E) and enters 

the camera. 
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Figure 4: DCRaw Reader (version 

1.3.0) dialog box.  The settings shown 

are the one used to analyze fluorescent 

light intensities.
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Table I: Statistical calculations of green flourescence. = 14000
Green pixel intensity (cpp) Wild type Heterozygous Homozygous | £ 15000
Mean (X) " 725.99" 40945" 1060622 | Z I
Alpha (a) 0.05 0.05 005 | § 10000 I
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Figure 1: Green fluorescence of GFP expressing plants.
Range bars are 95% confidence intervals.
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Introduction:

One of the praperties of chlorophyll i it becomes fluorescent when it accepts high
energy photons (Vodopich and Moore 2008). Because of advances n light emitting.
diode (LED) technology, high intensity colored light sources are now commercially
available. The goal of this project was to detemnine if digital cameras with a light filter
could be usedto determine the conceniration of chlorophylin Arabidopsisleaves.
‘Thus, a time exposure esperiment was conductedto determine if digital images of
chlorophyll fluoescence produced.a finear response.

Materials and Methods:
Wild type Arabidopsis eaves were ifuminated with a 5 watt royal biue LED

(Fig. 1). Light intensity on the leaves was ~1300 yE/m?s. Photographs of leaves were
taken with a Canon EOS 30 digital camera. To detect fluorescence, a Hoya brand Orange-
G fiter was usedto preventeflected blue light from entering the camera. Different
exposure times (1/100s to 30 5) were taken. Light intensities were measured from the
camera’s digital TIFF images with the software package Image] V3.8 (National Institutes
of Health 2006).

Figure 1: Photographing leaf fluorescence. Pots
containing Arabidopsis were fuminated with a 3 watt royal
biue LED. A Hoya brand Orange-G light filter was usedto
preventblue light from entering the camera. Photographs
wwere taken in a dark room.

Results:

Figure 2: Photographs of
Arabidopsisleaves illuminated with
white light and blue light. Color
‘photographs ofleaves lhuminated
with white light (Panel A) andblue
light (Panel B). Gray-scale images
of the red (Panel ), green (Panel D)
and blue (Panel E) channels of
Panel B's TIFF file viewed with
Imagel.

TIFF Digital Images of Leaf Fluoresces Cannot be Used to Measure Chlorophyll Concentration

in Arabidopsis thaliana.
D Haittam Greib and Stokes S. B

Fig. 3: Chlorophyll fluorescence light intensiy
detected with digital camera. Wild type
rabidopsisleaves were photographedfor varying.
‘amounts of time. Light intensity of the red (red
diamonds) green (green squares) and biue (blue
circles) channels of digital TIFF images were
‘measured with Image]. Range bars are 95%
confidence intervals
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Discussion:

‘When green plant feaves (Fig. 2, Panel A) were exposed tobiue light (Panel B) they
appeatedred. Since chlorophyll fluoresces red when exposed to high light intensity
(Vodopich and Moore 2008), the i2vivo color is fikely dueto chlorophyll fluorescence.
WhenImage] was usedto separate the color TIFF files into their component color
channels (Fig. 2), the predominant leaf color was red (Panel C) indicating that
chlorophyll fluorescence is being detected. Little green light (Panel D) or blue fight
(Panel E) was observed, thoughleaf hairs did brightly fluoresce green. Red fight
statistically had the greatestintensity (Fig. 3) Theseresultsindicate that the orange
camera filter was effective in preventing reflected biue light from entering the camera.
The linearity of the camera’s response to chlorophyll fluoresce was assessedby
‘measuring the mean light intensity (counts/pixel) at different exposure times (Fig. 3).
Unfortunately, the response was curved which makes quantification more dificult.
Though TIFF files donot lose digital information (Cromey 2006) photographic soft-
ware converts the linear RAW fles into logarithmic files to simulate the eyes response
to images (Hoffmann 2007). Thus, the TIFF file response wasnotlinear.

The red channel digital image intensity (Fig. 3) plateaued (fattens) at 2 mean pixel
intensity of 63 klocounts. This occurred because 16 bit digital camera detectors
‘becomes saturatedat 65,536 counts (Cromey 2006).

Because the TIFF file responseis non-linear and plateaus, measusing the chlorophyll
fluorescence would not be an accurate method to estimate b1 vivo chlorophyll
concentrations. Additionally, the fiter systemwill not allow detection of green
fluorescent protein because of the statistically high green background (Fig. 3).
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